UEILogger™ 300/600

High performance data logger/recorders

Flexible: Select the /0 boards installed to match your application

°
® Up to 150 analog inputs or 288 digital inputs per cube
® Easy-to-use, intuitive Windows setup/programming
e Stores data to standard SD Card (included)

® Sample up to 100 samples per second PER CHANNEL
® Compact

4" x 4.1" x 4" UElLogger 300
4" x 4.1" x 5.8" UElILogger 600

Rugged (tested -40 to +85 °C, 5g vib,, 50g shock)
Start/Stop Logging via CAN-bus command
Extremely cost effective

AC, DC or Battery powered

Program via Ethernet or load the logging/recording
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UEILogger300 shown

UEILogger consists of the CPU, Ethernet interface, SD
Card slot and either 3 (UEILogger 300) or 6 UEILogger
600) 1/ O slots. The slots are filled with the 1/O boards
required to match your application.

General Description:

The UElLogger is a powerful, flexible and easy-to-use data
logger/ recorder suitable for use in a wide variety of industrial,
aerospace, in-vehicle and laboratory applications. Based upon
UEl's popular PowerDNA Ethernet DAQ Cubes, the UEILogger
maintains all of the PowerDNA's flexibility and adds a power-
ful standalone data logging/recording capability.

The UElLogger is configured to meet the specific needs of your
application. The Logger Cube contains the controller, network
and SD card interface, power supply as well as either three or

six 1/O slots (UEILogger 300 . .
or 600 respectively). Configure Block Dlagram'

channels at 1 Hz for over two months! If you need more data
still, you may opt for a larger SD Card.

Simple and Flexible Setup

Developing the data logging application is simple with the
intuitive, Windows-based application provided. There is ab-
solutely no programming required. The software allows you
to set input and output ranges, sample/update rates, signal
conditioning, etc. all from simple pull down menus. Chan-
nels may be configured individually or to save time and effort
channels with common configu-
rations may set up as a group.

your logger by simply select-
ing the |/O boards required to

[ 4 MB Flash ] [ 128 VB DDRAM]

You may also set Alarm/trigger

match your application. With
over 20 different I/O boards
available, there's sure to be
a configuration to meet your
needs. (The UElLogger family
uses the same 1/O boards as
our PowerDNA cubes.)

9-36V DC Input

Freescale
PowerPC

conditions for input channels
that may used to control out-
puts, sound an audible alarm
and/or flash an LED. Please see
the screen captures at the end
of the data sheet for more info.
You may also download a copy

~—

32-bit 66-MHz bus

jLLL

Performance

——|

of the UElLogger application
and try it out at www.ueidag.
com/UElloggerdemo.
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The UElLogger supports sam-
ple rates up to 100 samples per
second on each |/O channel or port. For example, a 6 slot Log-
ger, full of 25 channel Al-225 boards has 150 input channels.
The logger will log all 150 channels at up to 100 s/s, for an
aggregate sample rate of 15,000 samples per second.
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Data is logged onto standard SD Cards up to 4 Gigabyte (2 Gig
SD Card included). Logged data may be retrieved via the unit's
Ethernet port or the SD Card may be removed from the log-
ger and read by any standard SD Card reader (available from
any office supply or computer retailer). The 2 Gig SD Card in-
cluded will hold over 500 million 16-bit A/D readings. Enough
to sample 144 analog inputs at 10 Hz for over four days, or 75
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The data logging “program” may
be loaded onto the UEILogger two ways. It may be download-
ed via the unit's standard Ethernet port. The logging applica-
tion configuration file may also be stored on the SD card. This
allows Logger applications to be modified or initiated and data
to be extracted simply by installing a new SD card.

The UEILogger software converts data on the SD Card (includ-
ing all configuration information) into formats used by popu-
lar DAQ and analysis applications. The software also allows
you to review the logged data graphically. The binary data
storage format will also be published for users wishing to read
the data directly from the SD card.
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General Description (continued):

Logger Timing Control
Logging applications may be started and stopped in many
ways. These include:

1. Initiated by host via Ethernet

2. On power up (start only!)

3. Start/Stop button

4. Real-time clock/calendar

5. Input from the Sync connector

6. An analog input crossing a trigger level (can be used to
trigger from a digital signal)

7. An analog input inside or outside a user selected range

Mounting and Power requirements

The UEILogger cubes offer a wide variety of mounting options.
A flange kit allows the cubes to be mounted to a wall or flat
surface. Rack and DIN Rail kits allow mounting in 19" racks or
on DIN rails respectively. For portable applications there is even
an attache style carrying case that will safely hold a cube, its
power supply, cables and screw terminal panels.

The UElLogger may be AC, DC or battery powered. The log-
ger includes a 115/230 VAC universal power supply for AC
powered applications. The logger may also be powered by any
9-36 VDC source or battery. Power consumption is dependent
on the 1/0 boards installed though will not typically exceed 12-
15 watts worst case. A standard automotive battery will supply
a fully loaded logger for roughly two days.

UEILogger Layout:

O Network Connectors

Ethernet in from host PC or from another Cube; The
Logger may be programmed via the ethernet port or the
program/configuration may be stored on the SD Card.
Data may be retrieved via ethernet or the SD Card may
be read directly with a standard SD Card reader..

© USB Port

USB Ver 1.1 port is not currently active.

@ SD Card Slot

Secure Digital (SD) Card slot for onboard data storage.
The SD Card is used as the data storage media in the
UEILogger series. It is also stores both data and linux em-
bedded programs deployed on the cube using the soon to
be released embedded toolkit. Supports FAT12, FAT16 and
FAT32 filesystems.

© Serial Port

@ 1/0 Board/Layer Slots

@ 1/0 Layer Status LEDs

These two green lights give a visual indication of the status
of each 1/0 layer.

RDY - Ready « STS - Status

® Sync Connector

High-speed Cube-to-Cube synchronization connector.

@ Start/Reset Button

Recessed to prevent accidental activation, this button may
be used to initiate logging applications of to reset the CPU
layer for activities such as downloading and installing new
firmware for the Cube.

© Communication Status LEDs

These LEDs monitor communications through the serial and
infrared ports.

ATT - Attention « R/W - Read/Write
COM - Communications underway
PG - Power Good / Ready

Using the supplied serial cable, you perform initial Pow-
erDNA setup of the operating parameters from any serial
terminal running at 57,600 baud/8 data bits/no parity/1
stop bit. From a terminal program you can, for instance,
change the IP address from the default, if necessary. You
also download updated firmware through the serial port.
The serial port is usable for RS-232 communications.

Loggers provide either 3 or 6 I/O slots. Boards installed
in the 1/0 slots perform the various analog, digital and
communications functions you need for your specific ap-
plication. Your signals may be connected directly to the
1/0 boards via your custom cabling or take advantage of
our wide variety of easy-to-use, external screw terminal
panels. Boards ordered with your logger are factory in-
stalled. It is also a simple task to add boards or reconfigure

© Power Connectors

Power-In, 9-36V DC either from the universal AC power
supply included with the Logger, a user-supplied source, or
daisychained from another Logger.

Power-Out (same voltage as applied to Power-In) to another

a logger in the field

Logger, if desired.

Software | Programming:

The data logger application is very intuitive. The initial screen allows

you to select the particular Logger Cube (if more than one are on the
network) as well as the 1/0O boards (also referred to as layers) you wish
to include in your logging application. You configure your application by
making selection in the Channels, Clock and Trigger, Alarms and Data
Tabs. You may view logged data in the View tab.
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Enabling and setting up the scaling and.signal conditioning options is a
snap. Just select from the options available in the various drop-down
boxes. The software only allows you to select options the board you are
using supports.
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Software (continued): : P
After selecting and configuring the channels to log, switch to the “Clock TEChnlcaI speﬂlflcatlonS:

and Trigger” tab. Here you select your logging sample rate as well as _
how you would like to initiate the logging. The “Alarms” tab allows you Standa il ateiace>

to set various alarm conditions, the “Data” tab allows you to select how To host computer 10/100Base-T, standard RJ-45 connector

the data will be formated and the “View"” tab allows you to View logged Daisy chain output | 10/100Base-T, standard RJ-45 connector
data Config/general RS-232, 9-pin "D”
1/0 Slots Available
Charnels ~Clock and Trigger |.-’-'«Iarm Setup | Data | wiew | UEILogger 600 6 slots
[ Master Trigger UEILogger 300 3 slots
—Layer Start Trigger Storage media Secure Digital (SD) Card
lirasr ILeveI ,I Storage capacity 4 Gigabyte (max), 2 Gbyte SD Card included
Data retrieval Via logger ethernet port or SD Card may be
Channel: IE 3’ read directly with a standard SD Card reader
Level O: |25 1/0 Performance
. 5 Max sample rate 100 samples per second PER CHANNEL.
Lewvel 1: :
Maximum aggregate rate 15 ks/s
Lianjpere I/0 Boards All PowerDNA analog/digital input boards
Type Freescale MPC5200, 400 MHz, 32-bit
DDRAM 128 MB
~Timing On-board Flash 4 MB
Scan Rate: |1U Clockiode:  DMap Status LEDs
; On front panel Attention, Read/Write, Power,
Clock 5ource: IEHtemaI Clk. J Communications Active

Environmental

Temp (operating) Tested to -40 °C to 85 °C

Pinout Diagrams:

Temp (storage) -40 °C to 100 °C
Power In' Power Qut? Humidity 0 to 95%, non-condensing
(molex) (molex) Vibration

(4 3 2 1|5 43 2 1] (IEC 60068-2-64) | 10-500 Hz, 5 g (rms), Broad-band random

oo L9 o £ (IEC 60068-2-6) 10-500 Hz, 5 g, Sinusoidal
=00 = =09 © = Shock 50 g, 3 ms half sine, 18 shocks at 6 orientations;
L . (IEC 60068-2-27) 30 g, 11 ms half sine, 18 shocks at 6 orientations
Synchronization  Serial (RS-232) Altitude 20,000 feet. maximum
I;l;l;l;‘ TXD CcTS Power Requirements
=93 RXD e Input voltage 9-36 VDC. 120/240 VAC unversal power
\g Ig 5 0 GND-[] supply included
=4
Ssgs ™ 3 ! Power consumption | 3.5 Watt max, plus power required by 1/0
Z I oo o I

o boards. Total power dissipation < 15 Watts
H I l Physical Dimentions

9
¢ ! UEILogger 300 41" x 4.0" x 4.0"

' Mating connector available from Digikey, Molex PN 39-01-4040 UEILogger 600 41" x 4.0" x 5.8"
2 Mating connector available from Digikey, Molex PN 39-01-4050

Ordering Guide:

Part Number Description
Loggers (includes software, 2 Gbyte SD Card, universal AC power supply, serial and ethernet cables)
UEILogger 300 3-Slot data logger/recorder
UEILogger 600 6-Slot data logger/recorder

Upgrades

DNA-Embedded Tool kit allows UEILogger to run standalone embedded Linux applications (Call for availability)

Accessories

DNA-SD4GB 4 Gigabyte SD Card
DNA-SD2GB 2 Gigabyte SD Card
DNA-DR5 Rear-mount DIN rail clip for UEILogger 300
DNA-DR8 Rear-mount DIN rail clip for UEILogger 600
DNA-FLANGE Bottom-mount flange assembly allows cube to be mounted to any flat surface
DNA-19RACKW 19" rackmount enclosure with DIN rail attached
DNA-CASE Light-weight plastic carrying case for PowerDNA Cube
DNA-CBL-37S 3ft, 37-way round shielded cable
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